Tutorial Ten

Residence Time Distribution

Bahram Haddadi

ENGINEERING
B FLUID
DYNAMICS

7t edition, March 2025

@ @ @ @ Except where otherwise noted, this work is licensed under
http://creativecommons.org/licenses/by-nc-sa/3.0/



ENGINEERING OoenFOAM® Basic Traini
FLUID pen asic Training

DYNAMICS Tutorial Ten

Contributors: M 1"(’ !Mgl!i!z!é
e Bahram Haddadi )—' NATURE

« Christian Jordan Technische Universitat Wien

e Michael Harasek Institute of Chemical, Environmental
e Clemens GoRnitzer & Bioscience Engineering

e Sylvia Zibuschka

e Yitong Chen

@ @ @ @ Except where otherwise noted, this work is licensed under
http://creativecommons.org/licenses/by-nc-sa/3.0/
Attribution-NonCommercial-ShareAlike 3.0 Unported (CC BY-NC-SA 3.0)
This is a human-readable summary of the Legal Code (the full license).
Disclaimer
You are free:
e to Share — to copy, distribute and transmit the work
e to Remix — to adapt the work
Under the following conditions:

e Attribution — you must attribute the work in the manner specified by the author or
licensor (but not in any way that suggests that, they endorse you or your use of the
work).

¢ Noncommercial — you may not use this work for commercial purposes.

e Share Alike — if you alter, transform, or build upon this work, you may distribute the
resulting work only under the same or similar license to this one.

With the understanding that:

e Waiver — any of the above conditions can be waived if you get permission from the
copyright holder.

e Public Domain — where the work or any of its elements is in the public domain under
applicable law, that status is in no way affected by the license.

e Other Rights — In no way are any of the following rights affected by the license:

e Your fair dealing or fair use rights, or other applicable copyright exceptions and
limitations;

The author's moral rights;
Rights other persons may have either in the work itself or in how the work is used,
such as publicity or privacy rights.

e Notice — for any reuse or distribution, you must make clear to others the license
terms of this work. The best way to do this is with a link to this web page.

This offering is not approved or endorsed by ESI® Group, ESI-OpenCFD® or the OpenFOAM®
Foundation, the producer of the OpenFOAM® software and owner of the OpenFOAM®
trademark.

Available from: www.fluiddynamics.at




ENGINEERING OoenFOAM® Basic Traini
B FLUID pen asic Training

DYNAMICS Tutorial Ten

Background

In this tutorial, we will carry out Residence Time Distribution (RTD) analysis of
fluid flow through a T-junction pipe.

1. Residence Time Distribution (RTD)

Residence Time Distribution (RTD) is a probability distribution function that
describes the amount of time a fluid element spends in a process unit, such as
a reactor, column, or pipe. Understanding RTD is crucial for analyzing the
performance, efficiency, and mixing characteristics of industrial systems. Unlike
ideal flow assumptions, most real-world fluid flows involve recirculation,
bypassing, and dispersion, which RTD helps quantify. A few RTD applications:

e Optimizing reactor design by ensuring effective residence time for
reactions.

¢ Identifying flow inefficiencies such as dead zones and short-circuiting.
e Enhancing mixing performance in industrial processes.

e Improving scale-up accuracy for chemical, pharmaceutical, and
wastewater applications.

By understanding RTD, engineers can optimize designs, improve product yield,
and enhance process reliability.

2. Tracer Analysis

Tracer analysis is a widely used technique for RTD measurement, where a
tracer substance (such as dye, salt, or radioactive material) is injected into the
system, and its concentration at the outlet is monitored over time. This provides
insight into how fluid elements move through the process unit and allows
engineers to quantify the RTD function.

inlet E®

Inject
tracer
Detect
tracer

outlet >
time

Tracer analysis and RTD distribution of an ideal process

Based on the above diagram, first the tracer is injected into the inlet, and then
the exit tracer concentration, C(t), is measured at regular time intervals. This
allows the exit age distribution, E(t), to be calculated.
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Cr(t) Tracer concentration at time t
B f0°° Cr(t) dt ~ Total tracer concentration

E(t)

It is clear from the above equation that the fraction of tracer molecules exiting
the reactor that have spent a time between t and t + dt in the process unit is
E(t)dt. Since all tracer elements will leave the unit at some point, RTD satisfies
the following relationship:

me(t) dt=1

Types of Flow Patterns Identified by RTD

e Ideal Plug Flow: All fluid particles have the same residence time,
resulting in a sharp, narrow RTD peak.

e Perfectly Mixed Flow (CSTR - Continuous Stirred Tank Reactor): Fluid
particles experience a wide range of residence times, leading to a broad
RTD distribution.

e Dead Zones and Recirculation: Cause multiple peaks in the RTD curve,
indicating poor mixing and stagnation.

e Bypassing Flow: Results in a steep initial RTD rise, meaning some fluid
exits much earlier than expected.
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incompressibleFluid & functions — TJunction

Tutorial outline

Use the incompressibleFluid and functions to simulate the flow through a
square cross section T pipe and calculate RTD (Residence Time Distribution)
for both inlets using a step function injection:

. Inlet and outlet cross-sections: 1 x 1 m?

. Gas in the system: air at ambient conditions

. Operating pressure: 10° Pa

. Inlet 1: 0.1 m/s

. Inlet 2: 0.2 m/s

Objectives

. Understanding RTD calculation using OpenFOAM®
. Using multiple solvers for a simulation

Data processing
Plot the step response function and the RTD curve.
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1. Pre-processing

1.1. Copying tutorial
Copy the following tutorial to your working directory as a base case:

SFOAM TUTORIALS/incompressibleFluid/pitzDaily

Replace the system directory with the system directory from the following
tutorial:

SFOAM TUTORIALS/incompressibleFluid/pitzDailySteadyExperi
mentalInlet

Copy the pitzDalily file for the pitzDaily geometry from following directory to your
system directory:

$FOAM7TUTORIALS/resources/blockMesh

1.2. Odirectory

Update p, U, nut, nuTilda, k and epsilon files with the new boundary conditions
(in this simulation the following boundaries should be set inlet_one, inlet_two,
oulet and walls), e.g. for file U:

//***************************************

******//

dimensions [01 -1 00 0 0];
internalField uniform (0 0 0);

boundaryField
{
inlet one
{
type fixedvalue;
value uniform (0.1 0 0)
}
inlet two

{

type fixedvalue;
value uniform (-0.2 0 0)
}
outlet
{
type zeroGradient;
}
walls
{
type fixedvalue;
value uniform (0 0 0)

}
}

// * k*k Kk *x Kk * Kk X*x * * *k *x * K, *k *x * * *k *x * * *k *x X * *k *x * * *k *x *x * *k *x *x * *

* kX Kk * ‘k//

1.3. constant directory
Check momentumTransport file for the turbulence model (kEpsilon).
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//***************************************

**‘k***//

simulationType RAS

RAS

{
model kEpsilon;
turbulence on;
printCoeffs on;

}

//*‘k*‘k*‘k*********************************

******//

1.4. system directory
Rename the pitzDalily file to blockMeshDict and edit it to create the geometry.

//***************************************

******//

convertToMeters 1.0;

vertices
(
(0 40) //0
(0 30) // 1
(3 30) // 2
(300) // 3
(4 00) // 4
(4 30) // 5
(7.3 0) // 6
(7.4 0) // 7
(4 40) // 8
(340 // 9
(0 4 1) // 10
(0 3 1) // 11
(3 31) // 12
(3 01) // 13
(4 0 1) // 14
(4 3 1) // 15
(7 3 1) // 16
(7 4 1) // 17
(4 4 1) // 18
(34 1) // 19
);
blocks
(
hex (01 2 9 10 11 12 19) (10 30 10) simpleGrading (1 1 1)
hex (9 2 58 19 12 15 18) (10 10 10) simpleGrading (1 1 1)
hex (8 5 6 7 18 15 16 17) (10 30 10) simpleGrading (1 1 1)
hex (2 3 4 5 12 13 14 15) (30 10 10) simpleGrading (1 1 1)
)
boundary

(
inlet one
{
type patch;
faces
(
(0 10 11 1)
)
}
inlet two
{
type patch;
faces
(
(7 6 16 17)
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)i
}
outlet

{
type patch;

faces
(
(4 3 13 14)
)i
}
walls
{
type wall;
faces
(
(01 29)
(2 58 9)
(5 6 7 8)
(2 3 405)
(10 19 12 11)
(19 18 15 12)
(18 17 16 15)
(15 14 13 12)
(0 9 19 10)
(9 8 18 19)
(8 7 17 18)
(2 1 11 12)
(3 2 12 13)
(5 4 14 15)
(6 5 15 16)

);

//***************************************
******//

2. Running simulation

>blockMesh

Mesh created using blockMesh

>foamRun -solver incompressibleFluid

Wait for simulation to converge. After convergence, check the results to make
sure about physical convergence of the solution.

>foamToVTK
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The simulation results are as follows (results are on the cut plane in the middle):

velocity magnitude (m/s) pressure(mz2/s2)
0.1 0.2 0.3 0.4 0 0,04 0,08

-0,04 0.11

Simulation results after convergence (~65 iterations)

3. RTD calculation

3.1. Copy tutorial
Copy following tutorial to your working directory:

SFOAM TUTORIALS/incompressibleFluid/pitzDailyScalarTransp
ort

In the O directory, just keep the T file and delete all other files.

3.2.  Odirectory

Copy and paste the U and p files from the latest time step of the simulation in
the first part of the tutorial (use the latest time step velocity field from previous
part of simulation to calculate RTD for this geometry). There is no need to
modify or change it. The solver will use this field to calculate the scalar
transportation.

Update T (T will be used as an inert scalar in this simulation) file boundary
conditions to match new simulation boundaries, to calculate RTD of the
inlet one setthe internalField valueto 0, T value for inlet one t0 1.0
and T value for inlet two to 0.

3.3. constant directory
In the momentumTransport file set the simulationType tO laminar.

3.4. system directory
Copy the blockMeshDict file from the first part of tutorial.

In the controlDict file change the endTime from 0.2 to 120 (approximately two
times ideal resistance time) and deltaT from 0.0001 to 0.1 (Courant number
approximately 0.4).
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4. Running Simulation
>blockMesh

>foamRun -solver functions
>foamToVTK

5. Post-processing

Contour plots scalar T at 120 s for inlet 1

5.1. Calculating RTD

To calculate RTD the average T value at the outlets should be calculated first.
The “integrate variables function” of ParaView can be used for this purpose.

>foamToVTK

Load the outlet VTK file into paraview using following path:

File > Open > VTK > outlet > outlet_..vtk > OK > Apply

Select T from variables menu, and then integrate the variables on the outlet:
Filters > Data Analysis > Integrate Variables > Apply

The values given in the opened window are integrated values in this specific
time step. By changing the time step values for different time steps are
displayed. As mentioned before, the average value of the property is needed.
Therefore, these values should be divided by outlet area to get average values
(Am x 1m).

After finishing the RTD calculations for inlet one, the same procedure should
be followed for calculating RTD of inlet two, except T value for inlet one
should be 0 and for inlet two it should be 1.0.
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Average value of T on the outlet for two inlets versus time

The average value of T for each outlet approaches a certain constant value,
which is the ratio of that scalar mass inlet to the whole mass inlet. For plotting
data over time “Plot Selection Over Time” option in ParaView can be used, in
the opened SpreadSheetView window (IntegrateVariables) select the set of
data which you want to plot over time and then:

Filters > Data Analysis > Plot Selection Over Time > Apply

Next, to obtain the RTD plots, export the data to a spreadsheet program (e.g.
Excel), calculate and plot the gradient of changes in average value of T on the
outlet from time 0 to 120s for both inlets.
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